
Using the Start Menu
Click the Start  button or press the Windows key to 
display the Start menu.
u Pinned Items List – 

contains shortcuts to 
programs that you 
have pinned to the 
Start menu.

v Most Frequently Used 
Programs List – contains 
shortcuts to the programs 
you use most frequently.

w All Programs – contains 
shortcuts to all programs 
on your computer.

x Search Box – allows you to 
quickly search your programs 
and personal folders.

y Right Pane – contains shortcuts to folders, programs, and 
features.

z Shut down button – allows you to 
close all open programs, shut down Windows, and turn off 
your computer.

{ Shut down button arrow – allows you to switch users, log off, 
lock, restart the computer, sleep or hibernate.

Using the Taskbar
• To add a toolbar to the Taskbar, right-click the Taskbar, select 

Toolbars, and select a toolbar from the shortcut menu.
• To change Taskbar properties, right-click the Taskbar, and 

select Properties from the shortcut menu. Make selections and 
click the OK button.

• To lock or unlock the Taskbar, right-click the Taskbar and 
select Lock the Taskbar from the shortcut menu.

• To customize what is displayed in the notification area, click the 
Show hidden icons  button. Click the Customize shortcut. 
Select icon and notification options and click the OK button.

 For one-click access to a folder on the Taskbar, right-click 
the Taskbar, select Toolbar, and select New toolbar from the 
shortcut menu. Locate and select the folder you want to display 
on the Taskbar and click the Select Folder button.

Working with Gadgets
The Sidebar is not available in Windows 7. But the components 
of the Sidebar, called Gadgets, are available. Gadgets are mini-
programs that display current, updated information.
• To display gadgets, right-click the Desktop and select Gadgets 

from the resulting menu.
• To display a gadget on the Desktop, click and drag the gadget 

to the place that you want it on the Desktop.
• To change gadget properties, right-click the gadget and select 

options from the shortcut menu.
• To close a gadget, click the Close  button in the upper-right 

corner of the gadget.

 To quickly minimize all windows except for one, select the 
Title Bar of the window you want to keep open and quickly shake 
your mouse pointer back and forth.
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Getting Started
The Windows 7 Desktop

u Icon – links to a program, file, or folder that is stored on the 
desktop.

v Shortcut Icon – links to a program, file, or folder that is 
stored in other sections of the computer.

w Start Menu – displays shortcuts to all programs, as well as 
the most frequently used folders and features.

x Taskbar – displays buttons and icons to help you navigate in 
Windows.

y Gadget – displays current, updated information. 
z Recycle Bin – contains deleted files.
{ Notification Area – contains icons for active and urgent 

notifications, as well as sound controls and the current date 
and time.

Using Jump Lists
Jump lists are a list of recent items that you can access from the 
taskbar button. Right-click the Taskbar button for a program and 
do any of the following from the shortcut menu:
• To open a recently used file, select the file name.
• To open the program, select the program name.
• To pin the taskbar button to the taskbar, select Pin this 

program to taskbar.
• To close the item, select Close window.

Working with Windows
• To arrange open windows, right-click the Taskbar and select 

Cascade Windows, Show Windows Stacked, or Show Windows 
Side by Side from the shortcut menu.

• To scroll through open windows, hold the Alt key and press the 
Tab key. (To open the selected window, release the Alt key.)

• To hide all open windows, right-click the Taskbar and select 
Show the desktop from the resulting menu or click the Show 
desktop  button in the bottom-right of the Taskbar.

Note: If you have transparency enabled, place your mouse pointer 
on the Show desktop button to quickly hide open windows.
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Files & Folders

Deleting a File or Folder
1. Select the file or folder you want to 

delete.
2. Click the Organize button on the 

toolbar.
3. Select Delete from the resulting menu.
4. Click the Yes button to confirm deletion.

Hiding a File or Folder
1. Select the file or folder you want to hide.
2. Click the Organize button on the toolbar.
3. Select Properties from the resulting menu.
4. Check the Hidden box.
5. Click the OK button. (If a dialog box appears, select whether 

you want to apply the change to the folder only or to all files 
and subfolders and click the OK button.)

Changing the Folder View
1. Open the folder you want to change the view for.
2. Click the arrow on the Change your view  button on the 

toolbar.
3. Select a view from the resulting menu, or click and drag the 

slider until the folder view you want is displayed.
Note: To quickly change the folder view, click the Change your view  

 button on the toolbar until the view you want is displayed.

Changing Folder Options
1. Open the folder you want to change options for.
2. Click the Organize button on the toolbar.
3. Select Folder and search options from the resulting menu.
4. On the General tab, make selections.
5. Optional: Click on the View tab and make additional selections.
6. Click the OK button when you are finished.
Note: To hide or display folder layout features such as the Menu 
bar, click the Organize button on the toolbar, select Layout, and 
select an option from the resulting menu.

Working with Libraries 
A library is used to organize folders into one collection no matter 
where they are originally stored on your computer. A folder is 
stored and displayed in the library, but is also stored in its original 
location.
• Adding or a folder to a library, select the folder on your 

computer that you want to include in a library. Click the 
Include in library button on the toolbar and select the library 
you want from the resulting menu.

• To create a new library, open a folder window and click the 
Libraries shortcut in the Navigation Pane. Click the New 
library button on the toolbar. Enter a name for the library and 
press the Enter key.

• To change a library’s default save location, open the library 
you want to change. Click the locations shortcut next to 
Includes. Right-click the folder you want to save as the default 
location and select Set as default save location from the 
resulting menu.

Creating a Shortcut to a File or Folder
1. Right-click the desktop.
2. Select New and select Shortcut from the resulting menu.
3. Click the Browse button.
4. Select the file or folder you want to create a shortcut for.
5. Click the OK button.
6. Click the Next button.
7. Enter a name for the shortcut and click the Finish button.

Files & Folders
The Windows 7 Folder Window
   

u Address Bar – displays the folder navigation.
v Forward and Back Buttons – allow you to navigate to folders 

that you have already opened.
w Toolbar – contains shortcuts for working with the folder or 

selected item.
x Navigation Pane – contains shortcuts to the Folders list and 

commonly used folders.
y Details Pane – displays the properties of the folder.
z Search Box – allows you to quickly search the current folder.
{ File List – displays the contents of the current folder or 

selected item.

Navigating in a Folder Window
• To go back to a previously opened folder, click the Back  

button.
• To go forward to a previously opened folder, click the 

Forward  button.
• To go to a recently opened folder, click the Recent Pages  

arrow and select a folder from the resulting menu.
• To go to a commonly used folder, select a folder in the 

Favorites section of the Navigation Pane.
• To go to a folder or location displayed in the Address Bar, click 

once on the folder or location name.
• To go to a subfolder of a folder displayed in the Address 

Bar, click on the arrow next to the folder name and select a 
subfolder from the resulting menu.

• To preview a file, without opening the program it was created 
in, select the file and click the Show the preview pane  
button on the toolbar.

Creating a New Folder
1. Open the folder that you want to create the new folder in.
2. Click the New folder button on the toolbar.
3. Enter a name for the folder and press the Enter key.

Renaming a File or Folder
1. Select the file or folder you want to rename.
2. Click the Organize button on the toolbar.
3. Select Rename from the resulting menu.
4. Enter a new name for the folder and press the Enter key.
Note: To quickly rename a file or folder, select the file or folder 
you want to rename. Press and hold the file or folder name until 
it displays a black box around it. Enter a name for the file or 
folder and press the Enter key.
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Personalizing

Personalizing
Changing the Desktop Background
1. Right-click the Desktop and select Personalize from the 

shortcut menu.
2. Click the Desktop Background shortcut.
3. Click the arrow on the Picture location box and select a folder 

from the resulting menu. (If the folder you want is not in the 
list, click the Browse button. Locate and select a picture in 
the folder you want and click the Open button.)

4. Do one of the following:
• To select one picture, select the picture.
• To select several pictures that will change at a specific 

interval, select the folder name. Make selections in the 
Change picture every section.

5. Optional: Click the Picture position box and select an option 
from the resulting menu.

6. Click the Save changes button.
7. Click the Close  button.
Note: If you selected several pictures for your background, you 
can manually change the background to the next picture. Right-
click the Desktop and select Next desktop background from the 
shortcut menu.

Changing the Window Color
1. Right-click the Desktop and select Personalize from the 

shortcut menu.
2. Click the Window Color shortcut.
3. Select the color you want.
4. Optional: Check or clear the Enable transparency box.
5. Optional: Click and drag the Color intensity slider.
6. Optional: To apply a customized color, click the Show color 

mixer button. Make changes in the Hue, Saturation, and 
Brightness sections.

7. Click the Save changes button.
8. Click the Close  button.

Working with Sounds
1. Right-click the Desktop and select Personalize from the 

shortcut menu.
2. Click the Sounds shortcut.
3. Do any of the following:

• To change the sound scheme, click the arrow on the Sound 
Scheme box and select a sound scheme from the resulting 
menu.

• To change the sound for a particular action, select the action 
in the Program box. Click the arrow on the Sounds box and 
select a sound from the resulting menu.

4. Optional: Check or clear the Play Windows Startup sound box.
5. Click the OK button.
6. Click the Close  button.

Applying a Screen Saver
1. Right-click the Desktop and select Personalize from the 

shortcut menu.
2. Click the Screen Saver shortcut.
3. Click the arrow on the Screen saver box and select a screen 

saver from the resulting menu.
4. Enter or select the amount of time you want the computer to 

be idle before the screen saver will start in the Wait box.
5. Optional: Check or clear the On resume, display logon screen 

box.
6. Click the OK button.
7. Click the Close  button.

Applying a Theme
1. Right-click the Desktop and select 

Personalize from the shortcut menu.
2. Select the theme you want to apply.
3. Click the Close  button.

 Use Aero themes to get the most out of 
your Windows 7 experience. Many features such as 
Windows Flip (displays live thumbnails of all open windows) and 
Flip 3D (a three-dimensional display of all open windows) are not 
available if Windows Aero is not enabled.

Customizing a Theme
1. Right-click the Desktop and select Personalize from the 

shortcut menu.
2. Make changes to the desktop background, window color, 

sounds, and screen saver. 
(The new theme will 
appear in the My Themes 
section.)

3. Click the Save theme 
shortcut.

4. Enter a name for the theme 
in the Theme name box.

5. Click the Save button.
6. Click the Close  

button.

Changing Desktop Icons
1. Right-click the Desktop and select Personalize from the 

shortcut menu.
2. Click the Change desktop icons shortcut.
3. Check the boxes for the icons you want to appear on the 

Desktop in the Desktop icons section.
4. Optional: To change the icon for an item select the item and 

click the Change Icon button. Select the icon that you want 
and click the OK button.

5. Optional: Check or clear the Allow themes to change desktop 
icons box.

6. Click the OK button.
7. Click the Close  button.

Changing Mouse Pointers
1. Right-click the Desktop and select Personalize from the 

shortcut menu.
2. Click the Change mouse pointers shortcut.
3. Click the arrow on the Scheme box and select a pointer 

scheme from the resulting menu.
4. Optional: To change mouse pointer options, click on the 

Pointer Options tab and make selections.
5. Click the OK button.
6. Click the Close  button.

Changing Your Account Picture
1. Right-click the Desktop and select Personalize from the 

shortcut menu.
2. Click the Change your account picture shortcut.
3. Do one of the following:

• To use a default picture, select the picture you want in the 
box.

• To use a picture on your computer, click the Browse for 
more pictures shortcut. Locate and select the picture you 
want and click the Open button.

4. Click the Close  button.
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Searching & Programs

Searching
Searching for an Item on Your Computer
1. Click the Start  button.
2. Enter what you want to search for in the Search programs and 

files box.
3. Do one of the following:

• To open item or location, click the item name in the Start 
menu.

• To view more results in specific group, click the group 
heading.

• To view all results, click the See more results shortcut.

Searching for an Item in a Folder
1. Open the folder you want to search.
2. Enter what you want to search for in the Search “Folder 

name” box. (The results will be displayed in the File list.)
3. Optional: To apply a search filter, click in the box. Press a 

search filter button and make selections.
4. Optional: To return to the folder view, select the text in the 

Search “Folder name” box and press the Delete key. 
5. Click the Close  button when you are finished.

 Windows 7 makes searching 
easier by showing sections of text 
with the search word or phrase 
highlighted. Turn on the Preview 
pane in the search results window 
so that you don’t have to open 
each document to find what you 
are looking for.

Saving Search Results
1. Search for an item on your computer or in a folder.
2. Click the Save Search button on the toolbar.
3. Enter a name for the search folder in the File name box or 

leave the default name.
4. Click the Save button.
Note: By default, a shortcut to the search will be displayed in the 
Favorites section of the Navigation Pane and the search itself is 
saved in the Searches folder located in your personal folder.

Programs
Creating a Shortcut to a Program
1. Click the Start 
Creating a Shortcut to a Program

 button.
2. Select All Programs from the Start menu.
3. Right-click the program you want to create a shortcut for.
4. Select Send To.
5. Select Desktop (create shortcut) from the resulting menu.

Pinning a Program to the Start Menu
When you “pin” a program to the Start menu it will always appear 
in the top-left pane of the Start menu.
1. Click the Start  button.
2. Select All Programs.
3. Right-click the program that you want to pin to the Start 

menu.
4. Select Pin to Start Menu from the shortcut menu.
Note: To remove an item from the Start menu, click the Start  
button, right-click the item you want to remove in the left pane, 
and select Remove from this list from the shortcut menu.

Setting a Default Program
1. Click the Start  button.
2. Select Control Panel in the right pane 

of the Start menu.
3. Click the Programs shortcut.
4. Click the Default Programs shortcut.
5. Click the Set your default programs shortcut.
6. Select the program you want in the Programs box.
7. Do one of the following:

• To set the program as the default for all file types, select Set 
this program as default.

• To choose which file types the program should be the default 
for, select Choose defaults for this program. Check the 
boxes for the file types you want to choose and click the Save 
button.

8. Click the OK button.
9. Click the Close  button.

Associating a File with a Program
1. Click the Start  button.
2. Select Control Panel in the right pane of the Start menu.
3. Click the Programs shortcut.
4. Click the Default Programs shortcut.
5. Click the Associate a file type or protocol with a program 

shortcut.
6. Select the file type you want to change.
7. Click the Change program button.
8. Select the program you want to open the selected file type with.
9. Click the OK button.
10. Click the Close button.
11. Click the Close  button.
Note: To quickly associate a file with a program, right-click the 
file, select Open With, and select Choose Default Program from 
the shortcut menu. Select the program you want to open the file 
type with and check the Always use the selected program to open 
this kind of file box. Click the OK button.

Using the Task Manager
The Task Manager displays all programs, services, and processes 
that are running on your computer. 
1. Right-click in the Taskbar.
2. Select Start Task Manager from the shortcut menu. 
3. Click on the Applications tab. 
4. Do one of the following:

• To view a program, select the program, and click the Switch 
To button. 

• To end a program that is not responding, select the program, 
and click the End Task button.

• To run a program from the Task Manager, click the New 
Task button. Click the Browse button. Locate and select the 
program you want to run, and click the Open button. Click 
the OK button. 

5. Click the Close  button.

Setting a Program to Run at Startup
1. Click the Start  button.
2. Select All Programs. 
3. Right-click the Startup menu.
4. Select Open from the resulting menu. 
5. Locate and select the shortcut to the program you want to run 

at startup. 
6. Click and drag the shortcut to the Startup folder. 
7. Click the Close  button.
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Accessories

Accessories
Using the Calculator
The calculator in Windows 7 allows you to switch modes, as well 
as convert units, calculate dates, and perform worksheet functions 
such as calculating a monthly payment or gas mileage.
1. Click the Start 
such as calculating a monthly payment or gas mileage.

 button.
2. Select All Programs and select Accessories.
3. Select Calculator.
4. Click on the View menu and do any of the following:

• To change the calculator type, select Standard, Scientific, 
Programmer, or Statistics from the resulting menu.

• To convert units of measurement, select Unit conversion and 
makes selections.

• To calculate dates, select Date calculation, make selections, 
and click the Calculate button.

• To perform worksheet functions, select Worksheets. Select 
a worksheet type, make selections, and click the Calculate 
button.

5. Click the Close  button when you are finished.

Working with Sticky Notes
1. Click the Start 
Working with Sticky Notes

 button.
2. Select All Programs and select Accessories.
3. Select Sticky Notes.
4. Enter text in the note that appears.
5. Optional: To create a new note, click the New Note  button.
6. Optional: To delete a note, click the Delete Note  button. 

Click the Yes button to confirm deletion.

Taking a Screen Capture
The Snipping Tool is a tool that can be used to capture a part of 
your screen or the entire screen. You can save the captures as an 
HTML, PNG, GIF, or JPEG file.
1. Click the Start 
HTML, PNG, GIF, or JPEG file.

 button.
2. Select All Programs and select Accessories.
3. Select Snipping Tool.
4. Click the arrow on the New button and do one of the following:

• To draw a freeform line around an object, select Free-form 
Snip. Click and drag your mouse around the area that you 
want to capture. 

• To draw a rectangle around an object, select Rectangular 
Snip. Click and drag to select the area you want to capture. 

• To capture an entire window, such as a browser or dialog 
box, select Window Snip. Move your mouse pointer to select 
the window that you want to capture. 

• To capture the entire screen, select Full-screen Snip. (The 
Snipping Tool will automatically capture the entire screen.)

5. Optional: To write on the capture, select Pen from the Tools 
menu and select a pen option from the resulting menu.

6. Optional: To highlight portions of the capture, select 
Highlighter from the Tools menu.

7. Optional: To copy the capture, select Copy from the Edit 
menu.

8. Optional: To send the capture, select Send To from the File 
menu and select E-mail Recipient or E-mail Recipient (as 
attachment) from the resulting menu.

9. Optional: To save the capture, select Save As from the File 
menu. Enter a name for the file in the File name box and click 
the Save button.

10. Click the Close  button when you are finished.
Note: You can also use the buttons on the Snipping Tool toolbar 
to edit, save, and send the capture. 

Working with WordPad
The improved WordPad interface in 
Windows 7 gives it the look and feel of 
Word 2007. You can open .doc and .docx 
files using WordPad.
1. Click the Start 
files using WordPad.

 button.
2. Select All Programs and select Accessories.
3. Select WordPad.
4. Enter and format text, graphics, and objects.
5. When you are finished, click the WordPad  tab.
6. Select Save from the resulting menu.
7. Optional: To save as another 

file type, click the arrow on 
the Save as type box and 
select a file type from the 
resulting menu.

8. Select a location to save the 
file.

9. Click the Save button.

Working with Notepad
Notepad is a program used for viewing and editing text files.
1. Click the Start 
Notepad is a program used for viewing and editing text files.

 button.
2. Select All Programs and select Accessories.
3. Select Notepad.
4. Optional: To apply a font to the whole document, select Font 

from the Format menu. Make selections in the Font, Style, 
and Size boxes. Click the OK button. 

5. When you are finished, select Save from the File menu.
6. Select a location to save the file.
7. Optional: Click the arrow on the Encoding box and select an 

option from the resulting menu.
8. Click the Save button.
Note: Font formatting is not saved with the file. 

Using the Sound Recorder
You can use the Sound Recorder to record audio directly onto your 
computer. You must have a sound card installed on your computer 
and you must also have access to a microphone or other audio 
input device.
1. Click the Start  button.
2. Select All Programs and select Accessories.
3. Select Sound Recorder.
4. Click the Start Recording button.
5. Record your audio. (Your elapsed time will be displayed in the 

Sound Recorder window.)
6. When you are finished, click the Stop Recording button.
7. Select a location to save the file.
8. Click the Save button.
9. Click the Close  button.

To order call toll-free 1-888-280-0424.
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Windows Key Shortcuts
Dock the current window to the 
left half of the screen ............. Win + Left Arrow 

Dock the current window to the 
right half of the screen ........... Win + Right Arrow 

Maximize the current window ..................................  Win + Up Arrow 
If the current window is maximized, restore it; 
if the current window is restored, minimize it ..........  Win + Down Arrow 

Minimize all but the current window ........................  Win + Home 
Quickly hide all open windows* ...............................  Win + Space
Display windows using Flip 3D* ...............................  Win + Tab 
Display windows Persistent Flip 3D* .......................  Ctrl + Win + Tab 

Display the Magnifier ................................................  Win + Plus Sign 

Open the projection menu  .......................................  Win + P
Cycle through applications’ live previews on taskbar  Win + T 

Minimize all open windows .......................................  Win + M 

Toggle hiding and showing the desktop ..................  Win + D 

Lock your computer ..................................................  Win + L 

Open the Search window .........................................  Win + F 

Open the Ease of Access window ...........................  Win + U 

Open System Properties in the Control Panel .........  Win + Pause
*Works only if you have an Aero theme applied.

Shortcuts & Getting Help 

Shortcuts
Copy the selected item ........................................................... Ctrl + C
Cut the selected item .............................................................. Ctrl + X
Paste the selected item .......................................................... Ctrl + V
Undo an action ........................................................................ Ctrl + Z
Delete selected item and move it to the Recycle Bin ........... Delete
Delete selected item without moving it to the Recycle Bin .. Shift + 

 ......................................................................................... Delete
Rename the selected item ...................................................... F2
Select all items in a document or window ............................. Ctrl + A
Search for a file or folder ........................................................ F3
Display properties for the selected item ................................ Alt + Enter
Close the active item or exit the active program .................. Alt + F4
Open the shortcut menu for the active window .................... Alt + Space
Close the active document ..................................................... Ctrl + F4
Switch between open items ................................................... Alt + Tab
Cycle through items in the order they were opened ............. Alt + Esc
Cycle through screen elements in a window or desktop ....... F6
Display the shortcut menu for the selected item .................. Shift + F10
Open the Start Menu ............................................................... Ctrl + Esc
Refresh the active window ..................................................... F5
Cancel the current task ........................................................... Esc
Display the Help and Support ................................................ F1
Open Windows Task Manager ................................................ Ctrl +  Shift

 ......................................................................................... + Esc

Getting Help
Browsing for Help Topics
1. Click the Start 
Browsing for Help Topics

 button.
2. Select Help and Support in the right pane of the Start 

menu.
3. Click the Browse Help  button on the toolbar.
4. Select a topic heading.
5. Click once on a topic to view Help information.
6. Click the Close  button when you are finished.
Note: You can also click the Browse Help topics shortcut in the 
Find an answer section of the Help and Support home window.

Searching for Help Topics
1. Click the Start 
Searching for Help Topics

 button.
2. Select Help and Support in the right pane of the Start 

menu.
3. Enter what you want to search for in the Search Help box.
4. Click the Search Help  button.
5. Click once on a topic to view Help information.
6. Click the Close  button when you are finished.

Getting Help in a Dialog Box or Window
Some windows and dialog boxes contain links to Help topics that 
are specific to the function you are performing. 
1. Do one of the following:

• To get Help in a dialog box, click the Help  button in 
the upper-right corner of the box.

• To get Help in a window, click the Get help  button on 
the toolbar.

2. Click once on a topic to view Help information.
3. Click the Close  button when you are finished.

Getting Online Help
When you are connected to the Internet, the most up to date 
information will be displayed when you search for Help.
1. Click the Offline Help  button at the bottom-

right corner of the Windows Help and Support window.
2. Select Get online Help from the resulting menu.

Finding Additional Help
If you did not find the answer to your question in Windows Help 
and Support, you can ask for help from experts and other Windows 
users, ask a friend for help, or go to the Microsoft Windows 
website. Click the Learn about other support options 
users, ask a friend for help, or go to the Microsoft Windows 

 button 
on the toolbar and make a selection.

Using Windows Basics
Windows Basics are Help topics for beginning 
computer users or users that are new to 
Windows 7.
1. Click the Help and Support home  

button on the toolbar.
2. Click the Learn about Windows Basics 

shortcut.
3. Click on a topic to view Help information.
4. Click the Close  button when you are finished.

Printing a Help Topic
1. Display the Help topic you want to print.
2. Click the Print  button on the toolbar.
3. Select print options.
4. Click the Print button to print the topic.

 button when you are finished.
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